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Introduction

This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

1 System Configuration

This section shows the types of External 

Devices which can be connected and SIO 

type.

"1 System Configuration" (page 3)

2 Selection of External Device

Select a model (series) of the External 

Device to be connected and connection 

method.

"2 Selection of External Device" (page 8)

3 Example of Communication Settings

This section shows setting examples for 

communicating between the Display and 

the External Device.

"3 Example of Communication Setting" 
(page 9)

4 Setup Items

This section describes communication 

setup items on the Display.

Set communication settings of the Display 

with GP-Pro Ex or in offline mode.

"4 Setup Items" (page 14)

5 Cable Diagram

This section shows cables and adapters 

for connecting the Display and the 

External Device.

"5 Cable Diagram" (page 17)

Operation
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1 System Configuration

The system configuration in the case when the External Device and the Display are connected is shown.

• Be sure to inform the Fanuc Corporation clearly that the system will be connected 
with Display.

Series CPU Link I/F SIO Type Setting Example
Cable 

Diagram

Fanuc Power 

Mate Series
Power Mate-
MODEL D

Port on CPU Unit*1

*1 The serial port used for the connection is different according to CPU. The serial port that can be used is as                    
follows.

RS422/485
(4wire)

Setting Example 1 
(page 9)

Cable Diagram 1 
(page 17)

Fanuc Power 

Mate i Series

Power Mate 
i-MODEL D

Power Mate 
i-MODEL H

Port on CPU Unit*1 RS422/485
(4wire)

Setting Example 1 
(page 9)

Cable Diagram 4 
(page 33)

Fanuc Series*2

*2 The touch panel function on the LCD of the CNC cannot be used simultaneously with the Display.

16-Model C Port2 on CPU Unit *1 RS232C
Setting Example 2 
(page 10)

Cable Diagram 2 
(page 26)

16-Model C
18-Model C
16i-Model A
16i-Model B
18i-Model A
18i-Model B
21i-Model A
21i-Model B
30i-Model A
31i-Model A
32i-Model A

Port2 on CPU Unit*1 RS232C
Setting Example 2 
(page 10)

Cable Diagram 3 
(page 29)

35i-Model B Port2 on CPU Unit*1 RS232C
Setting Example 3 
(page 12)

Cable Diagram 3 
(page 29)

CPU Serial port

PowerMate-MODEL D JD14

16-Model C JD5B

18-Model C
16i-Model A
16i-Model B
18i-Model A
18i-Model B
21i-Model A
21i-Model B

JD36B

30i-Model A
31i-Model A
32i-Model A
35i-Model B

JD36A or JD54

i-Model D
i-Model H

JD40
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 Connection Configuration

• 1:1 Connection

Display External Device
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 IPC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please 

refer to the IPC manual for details.

Usable port

Series
Usable Port

RS-232C RS-422/485(4 wire) RS-422/485(2 wire)

PS-2000B
COM1*1 , COM2, 
COM3*1, COM4

*1 The RI/5V can be switched. Use the IPC’s switch to change if necessary.

- -

PS-3450A, PS-3451A,
PS3000-BA, PS3001-BD

COM1, COM2*1*2 COM2*1*2 COM2*1*2

PS-3650A (T41 model),
PS-3651A (T41 model)

COM1*1 - -

PS-3650A (T42 model),
PS-3651A (T42 model)

COM1*1*2, COM2 COM1*1*2 COM1*1*2

PS-3700A (Pentium®4-M)
PS-3710A

COM1*1, COM2*1, 
COM3*2 , COM4

*2 Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

COM3*2 COM3*2

PS-3711A COM1*1, COM2*2 COM2*2 COM2*2

PS4000*3 COM1, COM2 - -

PL3000
COM1*1*2, COM2*1, 
COM3, COM4

COM1*1*2 COM1*1*2

PE-4000B Atom N270 COM1, COM2 - -

PE-4000B Atom N2600 COM1, COM2
COM3*4 , COM4*4, 
COM5*4, COM6*4

COM3*4, COM4*4, 
COM5*4, COM6*4

PS5000 (Slim Panel Type 
Core i3 Model) *5 *6 COM1, COM2*4 COM2*4 COM2*4

PS5000 (Slim Panel Type 
Atom Model) 
*5 *6

COM1, COM2*7 COM2*7 COM2*7

PS5000 (Enclosed Panel 
Type)*8 COM1 - -

PS5000 (Modular Type 
PFXPU/PFXPP)*5 *6

PS5000 (Modular Type 
PFXPL2B5-6)

COM1*7 COM1*7 COM1*7

PS5000 (Modular Type 
PFXPL2B1-4)

COM1, COM2*7 COM2*7 COM2*7

PS6000 (Advanced Box)
PS6000 (Standard Box)

COM1*9 *10 *10

PS6000 (Basic Box) COM1*9 COM1*9 COM1*9
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DIP Switch settings (PL3000 / PS3000 Series)

RS-232C

*3 When making communication between an External Device and COM port on the Expansion slot,             
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the             
specification of COM port.
For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

*4 Set up the SIO type with the BIOS. Please refer to the IPC manual for details of BIOS.

*5 When setting up communication between an External Device and the RS-232C/422/485 interface           
module, use the IPC (RS-232C) or PS5000 (RS-422/485) cable diagrams. However, when using            
PFXZPBMPR42P2 in a RS-422/485 (4-wire) configuration with no flow control, connect 7.RTS+           
and 8.CTS+, and connect 6.RTS- and 9.CTS-.
When using RS-422/485 communication with External Devices, you may need to reduce the            
transmission speed and increase the TX Wait time.

*6 To use RS-422/485 communication on the RS-232C/422/485 interface module, the DIP Switch           
setting is required. Please refer to "Knowledge Base" (FAQs) on the support site. (http://www.pro-             
face.com/trans/en/manual/1001.html)

*7 Set up the SIO type with the DIP Switch. Please refer to the IPC manual for details of DIP Switch.
The BOX Atom has not a switch to set the RS-232C, RS-422/485 mode. Use the BIOS for the                 
setting.

*8 For the connection with the External Device, on the user-created cable read as if the connector on                
the Display-side is a M12 A-coding 8 pin socket. The pin assignment is the same as described in                 
the cable diagram. For the M12 A-coding connector, use PFXZPSCNM122.

*9 In addition to COM1, you can also use the COM port on the optional interface.

*10 Install the optional interface in the expansion slot.

DIP Switch Setting Description

1 OFF*1

*1 When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

Reserved (always OFF)

2 OFF
SIO type: RS-232C

3 OFF

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

Settings FAQ ID

PFXZPBMPR42P2, RS422/485 change method FA263858

PFXZPBMPR42P2 termination resistor setting FA263974

PFXZPBMPR44P2, RS422/485 change method FA264087

PFXZPBMPR44P2 termination resistor setting FA264088
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RS-422/485 (4 wire)

RS-422/485 (2 wire)

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available

8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available

9 ON
RS (RTS) Auto control mode: Enabled

10 ON
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2 Selection of External Device

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

Manufacturer Select the manufacturer of the External Device to connect. Select "FANUC LTD.".

Series

Select the External Device model (series) and the connection method. Select "Power Mate 
Series".
In System configuration, make sure the External Device you are connecting is supported by 
"Power Mate Series".

"1 System Configuration" (page 3)

Port Select the Display port to connect to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory) 
of the External Device. When synchronized, you can use the External Device’s ladder program 
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area] 
Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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3 Example of Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are 

shown.

3.1 Setting Example 1

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

 Settings of External Device

Communication setting of External Device is as follows, and cannot be changed.

Setup Items Setup Description

SIO Type RS422/485 (4wire)

Data Rate 19200 bps

Data Length 8 bits

Parity Even

Stop Bits 1 bit

Flow Control None
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3.2 Setting Example 2

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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 Settings of External Device

Speed is set up by setting up the parameter by which a monitor is carried out by display of External Device. Other 

setup is fixed values and cannot be changed.

Procedure

The setting method of speed is explained to an example for 30i-Model A.

1 Permit the parameter writing.

Press the [OFFSET] key of an External Device operation board, and select the [Stting].

Change "0" of parameter writing into "1", and press the [INPUT] key.

2 Setting the parameter for display connection.

Press the [MDI] key of External Device operation board, and shift to MDI mode.

Press the [SYSTEM] key in MDI mode and the parameter screen is displayed.

Press the [Next page] and the parameter input screen is displayed.

Input the "3119" into parameter No. and the 3rd (3119. 3) bit is set to 0.

3 Setting the speed.

Setting the 1st (13101. 1) bit of parameter No.13101 to 1, and the setting value is written in parameter No.123.

4 Turn off the power supply of External Device, and turn on the power supply again.

Setup Items Setup Description

SIO Type RS232C

Speed Sets up with a parameter (refer to procedure).

Data Length 8 bits

Parity Even

Stop Bits 1 bit

Flow Control None

Setup Description (Dec) Data Rate (bps)

9 2400

10 4800

11 9600

12 19200

• When the 1st bit of parameter No.13101 is 0, a transfer rate is 19200bps fixation. When 

communicating by 19200bps, operation of Procedure 3 is unnecessary.
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3.3 Setting Example 3

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].



Power Mate Series Driver   

GP-Pro EX Device/PLC Connection Manual 13

 Settings of External Device

Use the CNC Screen Display Function software for setting up communication with the External Device. Refer to 

your External Device manual for details.

Procedure

1 Set the IP address of the personal computer to "192.168.1.200".

2 Set the IP address of the External Device to "192.168.1.10 +N".

The value of N is set with the rotary switch.

3 Connect an Ethernet cable to the CD38A Ethernet port and start the CNC Screen Display Function software.

4 Set the IP address of the HOST to "192.168.1.10".

5 From the [View] menu, select [Function key].

6 Click the [SYS] button until the parameter screen appears.

7 Enter the parameter number at command prompt A> and click [NO. SEARCH].

8 Enter the setting value at command prompt A> and click [Enter].

9 Turn off the power supply of External Device, and turn on the power supply again.

Setup Items Parameter Number Setting Value

I/O Channel 00020 2: RS-232C Serial Port 2 (JD-36A)

NFD / ASI / SB2 00121 0: 1Bit

IO SELECT CH2 00122 4: RS-232C

BAUDRATE CH2 00123 12: 19200bps
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

"3 Example of Communication Setting" (page 9)

4.1 Setup Items in GP-Pro EX

 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Setup Items Setup Description

SIO Type Select the SIO type to communicate with the External Device.

Speed Select speed between the External Device and the Display.

Data Length Display data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control
Select the communication control method to prevent overflow of transmission and 
reception data.

Timeout
Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.

RI/VCC
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
It is necessary to change RI/5V by changeover switch of IPC when connect with IPC. 
Please refer to the manual of the IPC for more detail.
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4.2 Setup Items in Offline Mode

Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list.

• Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"

• Refer to the Maintenance/Troubleshooting Guide for information on how to enter offline 

mode or about the operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 

Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

SIO Type

Select the SIO type to communicate with the External Device.

To make the communication settings correctly, confirm the serial interface specifications of 
Display unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does 
not support is specified.
For details concerning the serial interface specifications, refer to the manual for Display 
unit.

Speed Select speed between the External Device and the Display.

Data Length Display data length.

Parity Select how to check parity.
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 Option

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Option].

Stop Bit Select stop bit length.

Flow Control
Select the communication control method to prevent overflow of transmission and 
reception data.

Timeout
Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.

Setup Items Setup Description

RI/VCC
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
It is necessary to change RI/5V by changeover switch of IPC when connect with IPC. 
Please refer to the manual of the IPC for more detail.

• GP-4100 series, GP-4*01TM, GP-Rear Module, LT-4*01TM and LT-Rear module do not have 

the [Option] setting in the off-line mode.

Setup Items Setup Description
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5 Cable Diagram

The following cable diagrams may be different from cable diagrams recommended by External Device 

Manufacturer.

Please be assured there is no operational problem in applying the cable diagram shown in this manual.

• The FG pin of the External Device body must be grounded according to your country’s applicable standard. 

Refer to your External Device manual for details.

• SG and FG are connected inside the Display. When connecting the External Device to SG, design your system 

to avoid short-circuit loops.

• Connect an isolation unit if the communication is not stable due to noise or other factors.

5.1 Cable Diagram 1

Display

(Connection Port)
Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

1A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01 

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

*4 *5

1B User-created cable

GP3000*6 (COM2)

1C

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
*4 *5

1D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106  (COM1)
GP-4116T (COM1) 1E User-created cable *4 *5

GP4000*7 (COM2)
GP-4201T (COM1)
SP5000*8 (COM1/2)
SP-5B00 (COM2)
ST6000*9 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
PS6000 (Basic Box) 
(COM1/2)

1F

RS-422 terminal block conversion adapter by Pro-face
PFXZCBADTM1*10

+
User-created cable

*4 *5

1B User-created cable
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PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

1G User-created cable *4 *5

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,                
and PS6000)

 IPC COM Port (page 5)

*4 Check the cable length with Fanuc Motion Controller PLC's users manual.

*5 Connect a Termination Unit to the Motion Controller's JD15. The Termination Unit, with a resistance of 100
is connected to the RDB and RDA points.

*6 All GP3000 models except GP-3200 series and AGP-3302B

*7 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*8 Except SP-5B00

*9 Except ST-6200

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 1A.

*11 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.

 IPC COM Port (page 5)

Display

(Connection Port)
Cable Notes
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1A)

 

Terminal block

Signal name

Signal namePin

CA3-ADPTRM-01

CA3-ADPCOM-01

4

3

2

1

11

SDA

SDB

RDA

RDB

0V

TERM

RDA

RDB

SDA

SDB

SG

FG

Shield
Display

External Device (JD14)
Half-pitch 20pin (socket)

User-created cable
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1B)

Termination
resistance

100Ω  1/2W
Signal name

1

2

3

7

5

4

8

9

6

Shell

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

Pin

Display
D-Sub 9pin (Socket)

Signal namePin

4

3

2

1

11

SDA

SDB

RDA

RDB

0V

Shield

Display

External Device (JD14)
Half-pitch 20pin (socket)

User-created cable
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1C)

Display

Terminal block

Signal name

Signal namePin

CA3-ADPTRM-01

CA4-ADPONL-01

4

3

2

1

11

SDA

SDB

RDA

RDB

0V

TERM

RDA

RDB

SDA

SDB

SG

FG

Shield
External Device (JD14)
Half-pitch 20pin (socket)

User-created cable



Power Mate Series Driver   

GP-Pro EX Device/PLC Connection Manual 22

1D)

Display

Display
D-Sub 9pin (Plug)

Signal name

1

2

7

3

8

5

9

Shell

TERMRX

RDA

RDB

SDA

SDB

SG

TERMTX

FG

Pin

CA4-ADPONL-01

Signal namePin

4

3

2

1

11

SDA

SDB

RDA

RDB

0V

Shield
External Device (JD14)
Half-pitch 20pin (socket)

User-created cable
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1E)

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

Termination
resistance*1

Signal name

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Signal namePin

4

3

2

1

11

SDA

SDB

RDA

RDB

0V

Shield

Display

External Device (JD14)
Half-pitch 20pin (socket)

User-created cable

Display side 
Terminal block
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1F)

Terminal block 

Signal name 

Signal name Pin 

PFXZCBADTM1

4 

3 

2 

1 

11 

SDA 

SDB 

RDA 

RDB 

0V 

TERM 

RDA 

RDB 

SDA 

SDB 

SG 

FG 

Shield 
Display

External Device (JD14) 
Half-pitch 20pin (socket)

User-created cable 
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1G)

T ermination 
resistance 

100Ω  1/2W 
Signal name 

3

4

2

1

5 

7

8 

9 

6 

Shell 

Rx+

Rx-

Tx+

Tx-

NC

NC

NC

NC

GND

FG

Pin 

Display 
D-Sub 9pin (Socket) 

Signal name Pin 

4 

3 

2 

1 

1 1 

SD A 

SDB 

RD A 

RDB 

0V 

Shield 

Display 

External Device  (JD14) 
Half-pitch 20pin ( socket ) 

User-created cable 
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5.2 Cable Diagram 2

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.

 IPC COM Port (page 5)

2A

User-created cable
+

Fanuc's converting cable
A02B-0120-C19

The cable length must be 
15m or less.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1)

2B

User-created cable
+

Fanuc's converting cable
A02B-0120-C19

The cable length must be 
15m or less.
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2A)

• The cable length must be 15m maximum.

Display

Display
D-Sub 9pin (Socket)

Signal name

1

2

3

4

5

7

8

Shell

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

RS(RTS)

CS(CTS)

FG

Pin

External Device
D-Sub 25pin (Plug)

External Device

25pin 20pin

A02B-0120-C19

Signal name

4

2

3

5

6

7

8

20

1

RS

SD

RD

CS

DR

SG

CD

ER

FG

Pin
Shield

User-created cable
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2B)

• The cable length must be 5m maximum.

Display
Signal name

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

RS(RTS)

CS(CTS)

External Device
D-Sub 25pin (Plug)

External Device

25pin 20pin

A02B-0120-C19

Signal name

4

2

3

5

6

7

8

20

1

RS

SD

RD

CS

DR

SG

CD

ER

FG

Pin
Shield

User-created cable

Display side 
Terminal block
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5.3 Cable Diagram 3

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.

 IPC COM Port (page 5)

3A User-created cable
The cable length must be 
15m or less.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1)

3B User-created cable
The cable length must be 
15m or less.

LT-4*01TM 
(COM1)
LT-Rear Module 
(COM1)

3C
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21
The cable length must be 
5m or less.
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3A)

*1 When connecting with 30i-Model A, 31i-Model A or 32i-Model A, The pin number of SG changes with 
ports to be used.

• The cable length must be 15m maximum.

Use port Pin No. of SG

JD36A 8

JD54 4

Display

Signal name

2

3

4

5

6

7

8

Shell

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

FG

Pin

Display
D-Sub 9pin (Socket)

External Device
Half-pitch 20pin (Plug)

Signal namePin

11

1

8*1

3

7

13

5

15

SD

RD

SG

DR

CD

ER

CS

RS

Shield

User-created cable
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3B)

*1 When connecting with 30i-Model A, 31i-Model A or 32i-Model A, The pin number of SG changes with 
ports to be used.

• The cable length must be 15m maximum.

Use port Pin No. of SG

JD36A 8

JD54 4

Display

Signal name

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

External Device
Half-pitch 20pin (Plug)

Signal namePin

11

1

8*1

3

7

13

5

15

SD

RD

SG

DR

CD

ER

CS

RS

Shield

User-created cable

Display side 
Terminal block
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3C)

*1 When connecting with 30i-Model A, 31i-Model A or 32i-Model A, The pin number of SG changes with 
ports to be used.

Number Name Notes

(1)

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

• The cable length must be 5m maximum.

Use port Pin No. of SG

JD36A 8

JD54 4

External Device 
Half-pitch 20pin (Plug) 

Signal name Pin 

11

1

8*1

SD

RD

SG

Display

GND
TXD

RXD

(1)
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5.4 Cable Diagram 4

Display

(Connection Port)
Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,                
and PS6000)

 IPC COM Port (page 5)

4A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01 

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

Cable length:
1200m or less

4B User-created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B

4C

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

Cable length:
1200m or less

4D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106  (COM1)
GP-4116T (COM1) 4E User-created cable

Cable length:
1200m or less

GP4000*5 (COM2)
GP-4201T (COM1)
SP5000*6 (COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
PS6000 (Basic Box) 
(COM1/2)

*5 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6 Except SP-5B00

*7 Except ST-6200

4F

RS-422 terminal block conversion adapter by Pro-face
PFXZCBADTM1*8

+
User-created cable

*8 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 4A.

Cable length:
1200m or less

4B User-created cable

PE-4000B*9

PS5000*9

PS6000 (Optional 
Interface)*9

4G User-created cable
Cable length:
1200m or less
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*9 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.

 IPC COM Port (page 5)
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4A) 

• The cable length must be 1200m maximum.

CA3-ADPTRM-01

CA3-ADPCOM-01 TERM

RDA

RDB

SDA

SDB

SG

FG

4

3

2

1

12

6

8

5

7

*TXD

TXD

*RXD

RXD

0V

*RTS

*CTS

RTS

CTS

Display

Display

Signal name Shield

Signal namePin

External Device (JD40)
Half-pitch 20pin (socket)

Terminal block

User-created cable



Power Mate Series Driver   

GP-Pro EX Device/PLC Connection Manual 36

4B) 

• The cable length must be 1200m maximum.

4

3

2

1

12

6

8

5

7

*TXD

TXD

*RXD

RXD

0V

*RTS

*CTS

RTS

CTS

1

2

3

7

5

4

8

9

6

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

Display

Display

Shield
Signal nameSignal namePin Pin

External Device (JD40)
Half-pitch 20pin (socket)D-Sub 9pin (Socket)

100 Ω  (1/2W)

Shell

Terminal
resistance
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4C) 

• The cable length must be 1200m maximum.

CA3-ADPTRM-01

CA4-ADPONL-01 TERM

RDA

RDB

SDA

SDB

SG

FG

4

3

2

1

12

6

8

5

7

*TXD

TXD

*RXD

RXD

0V

*RTS

*CTS

RTS

CTS

Display

Display

Signal name Shield

Signal namePin

External Device (JD40)
Half-pitch 20pin (socket)

Terminal block

User-created cable
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4D) 

• The cable length must be 1200m maximum.

CA4-ADPONL-01 TERMRX

RDA

RDB

SDA

SDB

SG

TERMTX

FG

4

3

2

1

12

6

8

5

7

1

2

7

3

8

5

9

*TXD

TXD

*RXD

RXD

0V

*RTS

*CTS

RTS

CTS

Display

Display

Signal name ShieldPin

Signal namePin

External Device (JD40)

Shell

D-Sub 9 pin (plug)

Half-pitch 20pin (socket)

User-created cable
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4E)

 

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

• The cable length must be 1200m maximum.

4

3

2

1

12

6

8

5

7

*TXD

TXD

*RXD

RXD

0V

*RTS

*CTS

RTS

CTS

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Display

Shield
Signal nameSignal name Pin

External Device (JD40)
Half-pitch 20pin (socket)

 Terminal
resistance*1

Display side 
Terminal block
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4F) 

• The cable length must be 1200m maximum.

PFXZCBADTM1

TERM 

RDA 

RDB 

SDA 

SDB 

SG 

FG 

4 

3 

2 

1 

12 

6 

8 

5 

7 

*TXD 

TXD 

*RXD 

RXD 

0V 

*RTS 

*CTS 

RTS 

CTS 

Display

Display 

Signal name Shield 

Signal name Pin 

External Device (JD40) 
Half-pitch 20pin (socket)

Terminal block 

User-created cable 
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4G) 

• The cable length must be 1200m maximum.

4 

3 

2 

1 

12 

6 

8 

5 

7 

*TXD 

TXD 

*RXD 

RXD 

0V 

*RTS 

*CTS 

RTS 

CTS 

3

4

2

1

5

7

8

9

6

Rx+

Rx-

Tx+

Tx-

GND

NC

NC

NC

NC

FG

Display 

Display 

Shield 
Signal name Signal name Pin Pin 

External Device (JD40) 
Half-pitch 20pin (socket)D-Sub 9pin (Socket) 

100 Ω   (1/2W) 

Shell 

Terminal 
resistance 
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6 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of 

the devices varies depending on the External Device to be used. Please check the actual range in the manual of 

your External Device.

6.1 Fanuc Power Mate Series

 This address can be specified as system data area.

Device Bit Address Word Address
32

bits
Notes

Input relay
X00000.0-X00127.7
X01000.0-X01063.7

X00000-X00126
X01000-X01062

Output relay
Y00000.0-Y00127.7
Y01000.0-Y01063.7

Y00000-Y00126
Y01000-Y01062

Internal relay R00000.0-R00999.7 R00000-R00998

Keep relay K0000.0-K0019.7 K0000-K0018

Timer ----- T0000-T0078  

Counter ----- C0000-C0078  

Data table ----- D00000-D01858
 

*1

*1 The maximum address available for bit access is D01859.7.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

Supported Devices Symbol and Terms

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

device.chm::/PLC-002.htm
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6.2 Fanuc Power Mate i Series

 This address can be specified as system data area.

Device Bit Address Word Address
32

bits
Notes

Input relay
X00000.0-X00127.7
X01000.0-X01003.7
X01020.0-X01051.7

X00000-X00126
X01000-X01002
X01020-X01050

Output relay
Y00000.0-Y00127.7
Y01000.0-Y01002.7
Y01020.0-Y01051.7

Y00000-Y00126
        Y01000
Y01020-Y01050

Internal relay
R00000.0-R02999.7
R09000.0-R09199.7

R00000-R02998
R09000-R09198

*1

*1 Bit Address "R09000.0-R09199.7" and Word Address "R09000-R09198" are the system control          
areas. Do not write the data in these addresses.

Keep relay
K0000.0-K0039.7
K0900.0-K0909.7

K0000-K0038
K0900-K0908

*2

*2 Bit Address "K0900.0-K0909.7" and Word Address "K0900-K0908" are the system control areas.           
Do not write the data in these addresses.

Timer ----- T0000-T0298  

Counter ----- C0000-C0198  

Data table ----- D00000-D07998  *3

*3 The maximum address available for bit access is D07999.7.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

Supported Devices Symbol and Terms

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

device.chm::/PLC-002.htm
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6.3 Fanuc Series (16-Model C / 18-Model C / 16i-Model A /  16i-Model B / 
18i-Model A / 18i-Model B / 21i-Model A / 21i-Model B)

 This address can be specified as system data area.

Device Bit Address Word Address
32

bits
Notes

Input relay

X00000.0-X00127.7
X00200.0-X00327.7
X00400.0-X00527.7
X00600.0-X00727.7
X01000.0-X01127.7

X00000-X00126
X00200-X00326
X00400-X00526
X00600-X00726
X01000-X01126

 *1

*1 Write disable

Output relay

Y00000.0-Y00127.7
Y00200.0-Y00327.7
Y00400.0-Y00527.7
Y00600.0-Y00727.7
Y01000.0-Y01127.7

Y00000-Y00126
Y00200-Y00326
Y00400-Y00526
Y00600-Y00726
Y01000-Y01126

Internal relay R00000.0-R07999.7 R00000-R07998

Keep relay K00000.0-K00099.7 K0000-K00098

Timer ----- T0000-T0498  

Counter -----
C0000-C0398
C5000-C5198

 

Data table ----- D00000-D09998
 

*2

*2 The maximum address available for bit access is D09999.7.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

Supported Devices Symbol and Terms

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

device.chm::/PLC-002.htm
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6.4 Fanuc Series (30i-Model A / 31i-Model A / 32i-Model A)

 This address can be specified as system data area.

Device Bit Address Word Address
32

bits
Notes

Input relay

X00000.0-X00127.7
X00200.0-X00327.7
X00400.0-X00527.7
X00600.0-X00727.7
X01000.0-X01127.7

X00000-X00126
X00200-X00326
X00400-X00526
X00600-X00726
X01000-X01126

 *1

*1 Write disable

Output relay

Y00000.0-Y00127.7
Y00200.0-Y00327.7
Y00400.0-Y00527.7
Y00600.0-Y00727.7
Y01000.0-Y01127.7

Y00000-Y00126
Y00200-Y00326
Y00400-Y00526
Y00600-Y00726
Y01000-Y01126

Internal relay R00000.0-R07999.7 R00000-R07998

Keep relay K00000.0-K00099.7 K0000-K00098

Enhancing Relay E0000.0-E09999.7 E00000-E09998

Timer ----- T0000-T0498  

Counter -----
C0000-C0398
C5000-C5198

 

Data table ----- D00000-D09998
 

*2

*2 The maximum address available for bit access is D09999.7.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

Supported Devices Symbol and Terms

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

device.chm::/PLC-002.htm
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6.5 Fanuc Series (35i-Model B)

 This address can be specified as system data area.

Device Bit Address Word Address
32

bits
Notes

Input relay

X00000.0-X00127.7
X00200.0-X00327.7
X00400.0-X00527.7
X00600.0-X00727.7
X01000.0-X01127.7

X00000-X00126
X00200-X00326
X00400-X00526
X00600-X00726
X01000-X01126

 *1

*1 Write disable

Output relay

Y00000.0-Y00127.7
Y00200.0-Y00327.7
Y00400.0-Y00527.7
Y00600.0-Y00727.7
Y01000.0-Y01127.7

Y00000-X00126
Y00200-Y00326
Y00400-Y00526
Y00600-Y00726
Y01000-X01126

Internal relay
R00000.0-R07999.7
R09000.0-R09499.7

R00000-R07998
R09000-R09498

Keep relay
K00000.0-K00099.7
K00900.0-K00999.7

K00000 -K00098
K00900 -K00998

Enhancing Relay E0000.0-E09999.7 E00000-E09998

Timer -----
T0000-T0498
T9000-T9498

 

Counter -----
C0000-C0398
C5000-C5198

 

Data table ----- D00000-D09998
 

*2

*2 The maximum address available for bit access is D09999.7.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

Supported Devices Symbol and Terms

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

device.chm::/PLC-002.htm
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7 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

Device Device Name
Device Code

(HEX)
Address Code

Input relay X 0080 Word address / 2

Output relay Y 0081 Word address / 2

Internal relay R 0082 Word address / 2

Keep relay K 0083 Word address / 2

Enhancing Relay E 0089 Word address / 2

Timer T 0060 Word address / 2

Counter C 0061 Word address / 2

Data table D 0000 Word address / 2
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8 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA036: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

 Error Message Peculiar to External Device

Item Description

No. Error No.

Device Name
Name of External Device where error occurs. Device name is a title of External Device set 
with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes 
received from External Device.

• IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed such as "Address: Device address".
• Received error codes are displayed such as "Decimal [Hex]".

• Refer to your External Device manual for details on received error codes.

• Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the error 

messages common to the driver.

Message ID Error Message Description

RHxx128
(Node Name): Error has been responded for device read 
command (Major: [Hex], Minor: [Hex])

Error has been responded for 
device read command.

RHxx129
(Node Name): Error has been responded for device write 
command (Major: [Hex], Minor: [Hex])

Error has been responded for 
device write command.
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